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Lab 9 

First-Order Circuits and Oscilloscopes  

Objectives 
 

 concepts 

 

1. oscilloscopes 

2. trigger modes 

3. step response and natural response 

 

 skills 

 

1. measure signal characteristics with an oscilloscope scope 

2. experimentally determine the time constant of a first-order circuit 

Key Prerequisites 
 

 Chapter 7 (First-Order Circuits) 

Required Resources 
 

 Laptop, Circuit Kits, DMM, Digilent Analog Discovery (USB Oscilloscope) 

 Virtual Oscilloscope Flash Simulation  

 Getting Started Video for Digilent’s Analog Discovery 

 WaveForms Software for Digilent Analog Discovery 

 Getting Started with WaveForms 

 

Previously, we have utilized a multimeter to measure voltage, current, and resistance in electrical 

circuits. The oscilloscope is another basic instrument used to measure electrical quantities in a 

system and is an indispensable tool for an electrical, computer, or wireless engineer. An 

oscilloscope receives an electrical signal and converts it to a waveform that is displayed on a 

screen as shown in Figure 1. Engineers employ oscilloscopes as a diagnostic tool to determine if 

a system is working properly or not. As an example, a computer engineer could utilize an 

oscilloscope to examine the signals from a USB port to determine if it is functioning properly. 

A link to a virtual oscilloscope is listed above, which you can play around with to get the feel for 

how an “old time” oscilloscope used to work. A sample (more modern) oscilloscope display is 

shown in Figure 2. The waveform in the display shows the variation in voltage with time and is 

plotted on a graphical grid called a graticule. The vertical or y-axis of the graticule typically 

http://www.virtual-oscilloscope.com/oscilloscope/index_93_english.html
file:///C:/Users/tom/Documents/A%20www.tomrebold.com/engr12lab/LabsS14/•%09https:/www.youtube.com/watch%3flist=PLSTiCUiN_BoJ0ZwU5wj73OO_7BI2NcihM&v=aYgFKIsrOYQ
http://www.digilentinc.com/Products/Detail.cfm?NavPath=2,66,849&Prod=WAVEFORMS
file:///C:/Users/tom/Documents/A%20www.tomrebold.com/engr12lab/LabsS14/•%09http:/web02.gonzaga.edu/faculty/talarico/eeng303/documents/EE/WaveFormsOverview.pdf
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represents voltage, while the horizontal or x-axis typically represents time. 

Various buttons or knobs allow one to modify the view of the waveform being studied.  

 

Figure 2: An oscilloscope similar to the kind we use in the lab 

Oscilloscopes are essential tools, but can be costly and awkward to ship for online labs. 

Fortunately, cheaper and smaller options exist. Online students will use the Digilent Analog 

DiscoveryTM Portable Analog Circuit Design Kit, which includes a USB oscilloscope, to perform 

signal measurements in this and subsequent labs.  

An image of this device in action, with the WaveForms software that runs it, is shown in Fig 3.   

 
Fig 3. Analog DiscoveryTM connected to breadboard, with WaveFormsTM software display 
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The Analog Discovery is more than just a USB oscilloscope. The device combines the following 

instruments into one low cost package ($99 for students): 

 2 channel DC Power Supply (limited to +/- 5V and 50 mA each – we won’t be using this)  

 Voltmeter 

 2 channel Function Generator 

 2 channel Oscilloscope 

 16 channel Digital Pattern Generator 

 16 channel Logic Analyzer 

 Network Analyzer 

 Spectrum Analyzer 

 

Normally, the physical version of these devices would go for many tens of thousands of dollars if 
purchased separately. 

 

Discussion and Procedure 
 

 

Part 1: Oscilloscope Basics 

1) Before you can use the Analog Discovery, your computer will need a copy of WaveForms 

2015, installed on it. Visit the link below and start the download process, selecting all the 

standard choices unless you have a good reason to customize them.  

     http://store.digilentinc.com/waveforms-2015-download-only/  

2) For reference, the following diagram identifies all of the wires on the Analog Discovery 

Adapter box:  

 

http://www.digilentinc.com/data/products/analog-discovery/AnalogDiscovery.pdf
http://www.digilentinc.com/data/products/analog-discovery/AnalogDiscovery.pdf
http://store.digilentinc.com/waveforms-2015-download-only/
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3) To test your Analog Discovery device (we’ll call it AD from now on) configure the following 

setup shown in Fig 4 so that you can run a signal from the function generator (which generates 

a sinusoidal signal) into the oscilloscope (which displays it). Note that normally we would 

need to connect one of four ground (black) wires to our circuit, but for this activity we don’t 

need to hook up ground since the two instruments are tied together inside the box. Simply 

connect the orange (1+ on case) wire to the yellow (W1) wire, and the orange/white (1-) wire 

to any black wire () using the 6 pin header provided in the kit.  

 

    

Fig 4. Basic Test Setup: Function Generator (Yellow, and Black for ground) connected to 

Oscilloscope (Orange, and Orange/White for ground) 

4) Open the WaveForms 2015 software (we’ll call this the Welcome Window) by choosing All 

Programs > Digilent > WaveForms Application > Waveforms.  

 

 

Fig 5. WaveForms 2015 Instrument Selection Window 
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5) Click on the WaveGen Icon to bring up the Arbitrary Waveform Generator (aka Function 

Generator). This is the part of the Analog Discovery that generates sinewaves and other types 

of signals.  

 

6) Using the pulldown menus configure the generator to produce a 1 kHz sinewave, with an 

amplitude of 1V and a DC offset of 0V, as shown below. These happen to be the default 

settings, so you don’t have to change anything, although you can try modifying the settings 

and changing them back again for practice. Click the Run button and in a moment your 

display will look like the following. 

 

 
 

Fig 6. WaveGen set for a 1 kHz sinewave with a 1V amplitude.  

 To change from the default BLACK background, choose  

   Settings > Options > Analog Color and change from Dark to Light 

 

7) Now go back to the Welcome Window and choose the Scope option. In the Scope window, 

press RUN. You should see something like the following [Note that you can “pop out” the 

scope window by double clicking on its tab]:  
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Fig 6. Oscilloscope display (right) showing the sinewave generated by the WaveGen 

instrument (left). Note that the Scope display has been “popped out” of the WaveForms 

window by double-clicking on the “Scope 1” tab.  

8) Oscilloscopes have a number of settings that can make them confusing to operate. However, 

one nice feature is the AutoSet button (also found on most real oscilloscopoes). Unfortunately, 

this button is hidden by default – to find it, click the green “down arrow” (circled in Figure 6 

above) to reveal a second row of buttons. The expanded toolbar is shown with AutoSet circled 

in Figure 7 below. Click this button and wait for the system to calibrate. You may get a 

display that looks something like this.  

 

Fig 7. Oscilloscope display after AutoSet. To deactive Channel 2, uncheck the box circled. 
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9) The following skills are essential to modifying a signal display so you can inspect and 

measure various properties of any dynamic signal: 

a. Change the vertical scale 

b. Change the vertical offset 

c. Measure the peak-to-peak amplitude 

d. Change the horizontal scale (time base) 

e. Change the trigger modes 

f. Change the trigger threshold 

g. Measure the period (time between positive zero crossings) 

 

We are now going to experiment with each of these skills. Check out the video tutorial for help 

with these steps, which are fairly complex. 

 

10) Change the Vertical Scale and Offset – There is a box to the right of the display with a 

Channel 1 checkbox. This is the channel 1 vertical control box. Change the range to several 

different values, like 10 mV/div and 5 V/div. Change the offset to several different values, 

such as 200 mV and 1 V. You can also change the vertical offset by grabbing the triangle on 

the left side of display and dragging it up and down. Now press AutoSet and notice the 

offset changes back to 0V and the range to 1 V/div.  

 

11) Change the Horizontal Scale (time base) and Offset– Locate the Time checkbox above 

Channel 1. Change the base to 100 usec/div. You should have exactly one period of the 

sinewave in the window. Now change it to so that there are two to three periods in the 

display. The time offset allows you to slide the waveform left and right on the display. You 

can change the time offset by modifying the “Position” value under Time, or grab the 

downward pointing black triangle at the top of the display and drag it left or right. 

 

12) Change the Trigger Mode and Level – this controls what triggers the sampling so that the 

signal appears frozen on the display. Locate the box that says “Auto” and change it to 

“None.” You’ll notice the signal bouncing around the display randomly. This is what you 

get when no triggering is enabled. Change Mode  to Normal. Notice that the signal is frozen 

again. Make sure you observe the timestamp increasing rapidly at the top of the display. 

This means the signal is being updated and synchronized so it appears stationary.  

 

If you now change the trigger “Level” to 5V, the timestamp will appear frozen at the last 

valid sampling. This is because “Normal” only updates the signal when a trigger event 

occurs. If you change the mode back to “Auto”  you will see the signal jumping around 

again. This is because “Auto” shows the signal whether it is triggering or not. Set the 

“Level” to 1 V. You may notice the signal now appears frozen but vibrates a small amount. 

This is because the trigger value takes place at the top of a sinewave, which is susceptible to 

noise. Set the level back to 0V and the signal should appear stable again.  

 

Leaving the trigger mode in Auto is the best way to make sure you are seeing the signal, 
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even if it is not triggering properly. Note that you can change the trigger level graphically by 

dragging the yellow left or right pointing triangles up and down from the side of the display. 

 

13) Measure the Signal Characteristics –  You can also measure various properties of the 

signal using the measure too. To bring this up, choose View > Measure in the Oscilloscope 

window. A new window opens on your display. Click Add > Defined Measurement and 

click the triangle next to “Vertical”. Choose Peak-to-Peak, then Add to add the 

measurement to the window, as shown below: 

 

 
 

Fig 8. Oscilloscope Measurement feature, showing Peak2Peak amplitude 

 

 

14) Add another measurement to show the Period (time between positive zero crossings), which 

you can get at for Channel 1 under Horizontal. If you do not get a reading, change the 

horizontal scale (time base) so that are two or three periods or cycles of the sinewave in 

your window.  

 

15) Take a screen capture of your display with the current settings and measurements, and paste 

in your datasheet.  

 

We are now going to build a switched first-order capacitor circuit and measure its time constant. 
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Part 2: Measuring the Time Constant of a First Order Circuit 

Parts List 

 10 uF Capacitor (1)                       Push-button switch (1)              Resistors (1K, 100K (2) ) 

                      

WARNING – the 10 uF Capacitor is an electrolytic capacitor, which requires insertion into the 

circuit with the correct polarity. Placing an electrolytic capacitor in the circuit backwards could 

cause the capacitor to “pop” and render it unusable.  

 
16) Measure and record the resistance of your resistors in your datasheet.  

 
17) Construct the circuit shown in Figure 8. Note the placement of the 6 pin header on the 

breadboard, which is where we can attach the properly colored leads from the Analog 

Discovery. Also note that for improved noise reduction, we are connecting a black (ground) 

Analog Discovery wire to our breadboard as well.                                                                                       

   

Fig 9. Test circuit #1 

 

What follows is a general description of how to measure the RC time constant of your circuit. 

This is a very compliated task, so you are encouraged to watch the instruction provided at this 

video link. 

18) On the Analog Discovery (AD) start the oscilloscope running, but DO NOT press AutoSet 

(AutoSet works best with periodic signals, which ours is not). Set the Time Base to 500 

msec seconds, and the Range for Channel 1 to 2 V/div. Now close the switch and observe 
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the voltage across the capacitor on the scope. Open the switch and observe the voltage 

across the capacitor. Using the trigger functions of the scope, capture the capacitor voltage 

after the switch closes on the scope display (you can hit STOP when the trace reaches the 

right side of the display). The shape of your waveform should look something like the 

following: 

 

 
19) The Time Constant for an RC circuit is defined as Req * C,  where Req is the Thevenin 

resistance seen by the capacitor, and C is the capacitance. When the capacitor is charging, 

the switch is closed, and the Thevenin resistance seen by the capacitor includes the voltage 

source and both resistors.  

 

Find the formula for Req and compute it. 

 

Then compute the time constant and enter both into your data sheet.  

 

20) Now we will measure the time constant of the circuit while the capacitor is charging. Recall 

that you can find the time constant by finding how long it takes the capacitor voltage to 

reach 63.2% of its final value. Make sure your estimate of  is consistent with this 

understanding. Take a screen capture of your display and paste it into your datasheet. 

 

21) Add your scope measurements and theoretical calculations of the charging time constant to 

Table 1 in your datasheet.                         

 

22) Now open the switch and capture the capacitor voltage while the capacitor is discharging. 

Use the measurement feature to determine the time constant for the circuit. In this case, the 

time constant can determined by locating the time required for the capacitor voltage to reach 

36.8% of its initial value. Verify that this is what the measurement “Fall Time” is reporting. 

Your display should looks something like the following.  
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Insert a screen capture of your display of the discharge curve, including the time constant,   

       in your datasheet.  

23) Repeat parts 18 through 22 for the following modified circuit.  

 


